
Adobe Photoshop CC Spickzettel

Popular shortcuts
[ Decrease Brush Size

] Increase Brush Size

{ Decrease Brush Hardness

} Increase Brush Hardness

D Default Foreground/Background 
colors

X Switch Foreground/Background 
colors

Ctrl + J New layer via copy

Shift + Ctrl + J New layer via cut

Shift + Bewegen 
Sie die Maus

(With any selection tool) Add to a 
selection

Alt + Links Klick (Click on brush or swatch) 
Delete brush or swatch

Ctrl + Links Klick Toggle auto-select with move 
tool

Esc Cancel any modal dialog window 
(including the Start Workspace)

Enter Select the first edit field of the 
tool bar

Tab Navigate between fields

Tab + Shift Navigate between fields in 
opposite direction

Alt Change Cancel to Reset

Invoke the search experience
Ctrl + F Search across Photoshop UI, 

Help & Learn content, and 
Adobe Stock assets. For more 
information, see Photoshop 
search.

Using function keys
F1 Start Help

F2 Cut

F3 Copy

F4 Paste

F5 Show/Hide Brush panel

F6 Show/Hide Color panel

F7 Show/Hide Layers panel

F8 Show/Hide Info panel

F9 Show/Hide Actions panel

F12 Revert

Shift + F5 Fill

Shift + F6 oder 
Shift + F6

Feather Selection

Shift + F7 Inverse Selection

Selecting tools
Holding down a key temporarily activates a tool. 
Letting go of the key returns to the previous tool.

Shift (Press shortcut key while holding 
Shift) Cycle through tools with 
the same shortcut key

Alt + Links Klick (click on a tool, except Add 
Anchor Point, Delete Anchor 
Point, and Convert Point tools) 
Cycle through hidden tools

V Move tool

M Rectangular Marquee tool

M Elliptical Marquee tool

L Lasso tool

L Polygonal Lasso tool

L Magnetic Lasso tool

W Magic Wand tool

W Quick Selection tool

C Crop tool

C Slice tool

C Slice Select tool

I Eyedropper tool

I Color Sampler tool

I Ruler tool

I Note tool

J Spot Healing Brush tool

J Healing Brush tool

J Patch tool

J Red Eye tool

B Brush tool

B Pencil tool

B Color Replacement tool

B Mixer Brush tool
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S Clone Stamp tool

S Pattern Stamp tool

Y History Brush tool

Y Art History Brush tool

E Eraser tool

E Background Eraser tool

E Magic Eraser tool

G Gradient tool

G Paint Bucket tool

O Dodge tool

O Burn tool

O Sponge tool

P Pen tool

P Freeform Pen tool

T Horizontal Type tool

T Vertical Type tool

T Horizontal Type mask tool

T Vertical Type mask tool

A Path Selection tool

A Direct Selection tool

U Rectangle tool

U Rounded Rectangle tool

U Ellipse tool

U Polygon tool

U Line tool

U Custom Shape tool

H Hand tool

R Rotate View tool

Z Zoom tool

D Default Foreground/Background 
colors

X Switch Foreground/Background 
colors

Q Toggle Standard/Quick Mask 
modes

J Content-Aware Move tool

C Perspective Crop tool

V Artboard tool

R Rotate View tool

/ Toggle Preserve Transparency

{ Decrease Brush Hardness

} Increase Brush Hardness

, Previous Brush

. Next Brush

< First Brush

> Last Brush

View images
Ctrl + Tab Cycle through open documents

Shift + Ctrl + Tab Switch to previous document

Shift + Ctrl + W Close a file in Photoshop and 
open Bridge

Q Toggle between Standard mode 
and Quick Mask mode

F Toggle (forward) between 
Standard screen mode, Full 
screen mode with menu bar, and 
Full screen mode

Shift + F Toggle (backward) between 
Standard screen mode, Full 
screen mode with menu bar, and 
Full screen mode

Space + F Toggle (forward) canvas color 
 (or right-click canvas 
background and select color)

Space + Shift + F Toggle (backward) canvas color

Doppelklick (Double-click the hand tool) Fit 
image in window

Doppelklick (Double-click the zoom tool) 
Magnify 100%

Ctrl + 1 Magnify 100%

Space Switch to Hand tool (when not in 
text-edit mode)

Shift + Bewegen 
Sie die Maus

Simultaneously pan multiple 
documents with Hand tool

Ctrl + Space Switch to Zoom In tool

Alt + Space Switch to Zoom Out tool

Space + Bewegen 
Sie die Maus

Move Zoom marquee while 
dragging with the Zoom tool

Shift + Enter (In Navigator panel zoom 
percentage box) Apply zoom 
percentage, and keep zoom 
percentage box active
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Ctrl + Bewegen 
Sie die Maus

(Over preview in Navigator 
panel) Zoom in on specified area 
of an image

H + Links Klick (Hold the mouse button) 
Temporarily zoom into an image

Space + Bewegen 
Sie die Maus

Scroll image with Hand tool

Page Up Scroll up 1 screen

Page Down Scroll down 1 screen

Page Up Scroll up 10 units

Page Down Scroll down 10 units

Home Move view to upper-left corner

End Move view to lower-right corner

\ Toggle layer mask on/off as 
rubylith (layer mask must be 
selected)

Using puppet warp
Esc Cancel completely

Ctrl + Z Undo last pin adjustment

Ctrl + A Select all pins

Ctrl + D Deselect all pins

Shift + Links Klick Select multiple pins

Shift + Bewegen 
Sie die Maus

Move multiple selected pins

H Temporarily hide pins

Using refine edge
Ctrl + Alt + R Open the Refine Edge dialog 

box

F Cycle (forward) through preview 
modes

Shift + F Cycle (backward) through 
preview modes

X Toggle between original image 
and selection preview

P Toggle between original 
selection and refined version

J Toggle radius preview on and off

Shift + E Toggle between Refine Radius 
and Erase Refinements tools

Using Filter Gallery
Alt + Links Klick (Click on a filter) Apply a new 

filter on top of selected

Ctrl + Alt + F Reapply last-used filter

Alt + Links Klick (Click a disclosure triangle) 
Open/close all disclosure 
triangles

Ctrl Change Cancel button to Default

Alt Change Cancel button to Reset

Ctrl + Z Undo/Redo

Ctrl + Shift + Z Step forward

Ctrl + Alt + Z Step backward

Using liquify filter
W Forward Warp tool

R Reconstruct tool

C Twirl Clockwise tool

S Pucker tool

B Bloat tool

O Push Left tool

M Mirror tool

T Turbulence tool

F Freeze Mask tool

D Thaw Mask tool

Alt (Click on a tool) Reverse 
direction for Bloat, Pucker, Push 
Left, and Mirror tools

Alt (Drag in preview with 
Reconstruct tool, Displace, 
Amplitwist, or Affine mode 
selected) Continually sample the 
distortion

Aufwärtspfeil / 
Pfeil nach unten

(In Brush Size, Density, 
Pressure, Rate, or Turbulent 
Jitter text box) 
Decrease/increase brush size by 
2, or density, pressure, rate, or 
turbulent jitter by 1

(With Brush Size, Density, 
Pressure, Rate, or Turbulent 
Jitter slider showing) 
Decrease/increase brush size by 
2, or density, pressure, rate, or 

Linker Pfeil / 
Rechter Pfeil
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turbulent jitter by 1

Tab Cycle through controls on right 
from top

Shift + Tab Cycle through controls on right 
from bottom

Alt Change Cancel to Reset

Using vanishing point
X Zoom 2x (temporary)

Ctrl + + Zoom in

Ctrl + - Zoom out

Ctrl + 0 Fit in view

Doppelklick (on Hand tool) Fit in view

Doppelklick (on Zoom tool) Zoom to center at 
100%

] Increase brush size (Brush, 
Stamp tools)

[ Decrease brush size (Brush, 
Stamp tools)

Shift + ] Increase brush hardness (Brush, 
Stamp tools)

Shift + [ Decrease brush hardness 
(Brush, Stamp tools)

Ctrl + Z Undo last action

Ctrl + Shift + Z Redo last action

Ctrl + D Deselect all

Ctrl + H Hide selection and planes

Pfeiltasten Move selection 1 pixel

Shift + Pfeiltasten Move selection 10 pixels

Ctrl + C Copy

Ctrl + V Paste

Ctrl + Shift + T Repeat last duplicate and move

Ctrl + Alt + T Create a floating selection from 
the current selection

Ctrl + Bewegen 
Sie die Maus

Fill a selection with image under 
the pointer

Ctrl + Alt + 
Bewegen Sie die 
Maus

Create a duplicate of the 
selection as a floating selection

Alt + Shift Constrain selection to a 15° 
rotation

Select a plane under another Ctrl + Links Klick

selected plane

Ctrl + Bewegen 
Sie die Maus

Create 90 degree plane off 
parent plane

Backspace Delete last node while creating 
plane

Doppelklick (On the Create Plane tool) Make 
a full canvas plane, square to the 
camera

Using the Camera Raw dialog box
Note: Holding down a key temporarily activates a tool. 
Letting go of the key returns to the previous tool.

Z Zoom tool

H Hand tool

I White Balance tool

S Color Sampler tool

C Crop tool

A Straighten tool

B Spot Removal tool

E Red Eye Removal tool

Ctrl + Alt + 1 Basic panel

Ctrl + Alt + 2 Tone Curve panel

Ctrl + Alt + 3 Detail panel

Ctrl + Alt + 4 HSL/Grayscale panel

Ctrl + Alt + 5 Split Toning panel

Ctrl + Alt + 6 Lens Corrections panel

Ctrl + Alt + 7 Camera Calibration panel

Ctrl + Alt + 9 Presets panel

Ctrl + Alt + 9 Open Snapshots panel

Ctrl + Alt + Shift + 
T

Parametric Curve Targeted 
Adjustment tool

Ctrl + Alt + Shift + 
H

Hue Targeted Adjustment tool

Ctrl + Alt + Shift + 
S

Saturation Targeted Adjustment 
tool

Ctrl + Alt + Shift + 
L

Luminance Targeted Adjustment 
tool

Ctrl + Alt + Shift + 
G

Grayscale Mix Targeted 
Adjustment tool

T Last-used Targeted Adjustment 
tool

K Adjustment Brush tool
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G Graduated Filter tool

] oder [ Increase/decrease brush size

Shift + ] oder Shift 
+ [

Increase/decrease brush feather

= oder - Increase/decrease Adjustment 
Brush tool flow in increments of 
10

Alt Temporarily switch from Add to 
Erase mode for theAdjustment 
Brush tool, or from Erase to Add 
mode

Alt + ] oder Alt + [ Increase/decrease temporary 
Adjustment Brush tool size

Alt + Shift + ] oder 
Alt + Shift + [

Increase/decrease temporary 
Adjustment Brush tool feather

Alt + = oder Alt + - Increase/decrease temporary 
Adjustment Brush tool flow in 
increments of 10

N Switch to New mode from Add or 
Erase mode of theAdjustment 
Brush tool or the Graduated 
Filter

M Toggle Auto Mask for 
Adjustment Brush tool

Y Toggle Show Mask for 
Adjustment Brush tool

V Toggle pins for Adjustment 
Brush tool

V Toggle overlay for Graduated 
Filter, Spot Removal tool, or Red 
Eye Removal tool.

L oder Ctrl + ] Rotate image left

R oder Ctrl + [ Rotate image right

Ctrl + + Zoom in

Ctrl + - Zoom out

Ctrl Temporarily switch to Zoom In 
tool (Doesn’t work when 
Straighten tool is selected. If 
Crop tool is active, temporarily 
switches to Straighten tool)

Alt Temporarily switch to Zoom Out 
tool and change the Open Image 
button to Open Copy and the 
Cancel button to Reset

P Toggle preview

F Full screen mode

Shift Temporarily activate the White 
Balance tool and change the 
Open Image button to Open 
Object (Does not work if Crop 
tool is active)

Click the first point; Shift-click additional points: Select 
multiple points in Curves panel

Ctrl + Links Klick (In preview) Add point to curve in 
Curves panel

Pfeiltasten Move selected point in Curves 
panel (1 unit)

Shift + Pfeiltasten Move selected point in Curves 
panel (10 units)

Ctrl + R Open selected images in 
Camera Raw dialog box from 
Bridge

Shift + Doppelklick Open selected images from 
Bridge bypassing Camera Raw 
dialog box

Alt + Bewegen Sie 
die Maus

(Exposure, Recovery, or Black 
sliders) Display highlights that 
will be clipped in Preview

O Highlight clipping warning

U Shadows clipping warning

Ctrl + 1 ... to 5: (Filmstrip mode) Add 1 - 
5 star rating

Ctrl + . oder Ctrl + 
,

(Filmstrip mode) 
Increase/decrease rating

Ctrl + 6 (Filmstrip mode) Add red label

Ctrl + 7 (Filmstrip mode) Add yellow 
label

Ctrl + 8 (Filmstrip mode) Add green label

Ctrl + 9 (Filmstrip mode) Add blue label

Ctrl + Shift + 0 (Filmstrip mode) Add purple 
label

Ctrl + K Camera Raw preferences

Ctrl + Alt (On open) Deletes Adobe 
Camera Raw preferences

Using the Black-and-White dialog 
box

Shift + Ctrl + Alt + 
B

Open the Black-and-White dialog 
box
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Aufwärtspfeil / 
Pfeil nach unten

Increase/decrease selected 
value by 1%

Shift + 
Aufwärtspfeil / 
Pfeil nach unten

Increase/decrease selected 
value by 10%

Links Klick + 
Bewegen Sie die 
Maus

Change the values of the closest 
color slider

Using curves
Ctrl + M Open the Curves dialog box

+ Select next point on the curve

- Select the previous point on the 
curve

Shift + Links Klick (Click on points) Select multiple 
points on the curve

Ctrl + D Deselect a point

Del (Select a point first and press 
Delete) To delete a point on the 
curve

Pfeiltasten Move the selected point 1 unit

Shift + Pfeiltasten Move the selected point 10 units

Alt + Bewegen Sie 
die Maus

(Drag Black/white point sliders) 
Display highlights and shadows 
that will be clipped

Ctrl + Links Klick (On image) Set a point to the 
composite curve

Shift + Ctrl + Links 
Klick

(Click the image) Set a point to 
the channel curves

Alt + Links Klick (On the field) Toggle grid size

Selecting and moving objects
Space + Bewegen 
Sie die Maus

(Any marquee tool except single 
column and single row) 
 Reposition marquee while 
selecting. Applies to shape toos

Shift + Bewegen 
Sie die Maus

(Any selection tool) Add to a 
selection

Alt + Bewegen Sie 
die Maus

(Any selection tool) Subtract 
from a selection

Shift + Alt + 
Bewegen Sie die 
Maus

(Any selection tool except Quick 
Selection tool) Intersect a 
selection

Shift + Bewegen Constrain marquee to square or 

Sie die Maus circle (if no other selections are 
active). Applies to shape tools

Alt + Bewegen Sie 
die Maus

Draw marquee from center (if no 
other selections are active)

Shift + Alt + 
Bewegen Sie die 
Maus

Constrain shape and draw 
marquee from center

Ctrl (except when Hand, Slice, Path, 
Shape, or any Pen tool is 
selected) Switch to Move tool

Alt + Bewegen Sie 
die Maus

Switch from Magnetic Lasso tool 
to Lasso tool

Alt + Bewegen Sie 
die Maus

Switch from Magnetic Lasso tool 
to polygonal Lasso tool

Enter oder Esc 
oder Ctrl + .

Apply/cancel an operation of the 
Magnetic Lasso

Alt + Bewegen Sie 
die Maus

(On Move tool) Move copy of 
selection

Pfeiltasten (On any selection) Move 
selection area 1 pixel. Hold down 
Shift to move 10 pixels

Pfeiltasten (On Move tool) Move selection 1 
pixel. Applies to shape tools. 
Hold down Shift to move 10 
pixels

Ctrl + Pfeiltasten Move layer 1 pixel when nothing 
selected on layer. Hold down 
Shift to move 10 pixels

[ oder ] (On Magnetic Lasso tool) 
Increase/decrease detection 
width

Enter oder Esc (On Crop tool) Accept cropping 
or exit cropping

/ Toggle crop shield off and on

Alt + Bewegen Sie 
die Maus

(Ruler tool, Alt-drag end point) 
Make protractor

Shift + Bewegen 
Sie die Maus

(Drag guide) Snap guide to ruler 
ticks (except when View > Snap 
is unchecked)

Alt + Bewegen Sie 
die Maus

(Drag guide) Convert between 
horizontal and vertical guide

Transform selections, selection 
borders, and paths

Alt Transform from center or reflect
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Shift Constrain

Ctrl Distort

Enter Apply

Ctrl + . oder Esc Cancel

Ctrl + Alt + T Free transform with duplicate 
data

Ctrl + Shift + Alt + 
T

Transform again with duplicate 
data

Edit paths
Shift + Links Klick (Direct selection tool) Select 

multiple anchor points

Alt + Links Klick (Direct selection tool) Select 
entire path

Ctrl + Alt + 
Bewegen Sie die 
Maus

(On Pen (any Pen tool), Path 
Selection or Direct Selection 
tool) Duplicate a path

Ctrl Switch from Path Selection, Pen, 
Add Anchor Point, Delete Anchor 
Point, or Convert Point tools to 
Direct Selection tool

Alt Switch from Pen tool or Freeform 
Pen tool to Convert Point tool 
when pointer is over anchor or 
direction point

Doppelklick (Magnetic pen tool) Close path

Alt + Doppelklick (Magnetic pen tool) Close path 
with straight-line segment

Using for painting
Shift + Alt + 
Rechtsklick + 
Bewegen Sie die 
Maus

(Any painting tool) Select 
foreground color from color 
picker

Alt (Any painting tool or any shape 
tool) Select foreground color 
from image with Eyedropper tool 
(except when Paths option is 
selected)

Alt + Links Klick (Eyedropper tool) Select 
background color

Shift (Eyedropper tool) Color sampler 
tool

(Color sampler tool) Deletes Alt + Links Klick

color sampler

[0 - 9] (Any painting or editing tool  + 
number keys) Sets opacity, 
tolerance, strength, or exposure 
for painting mode

Shift + [0 - 9] (Any painting or editing tool) 
 (when airbrush option is 
enabled, omit Shift) Sets flow for 
painting mode (e.g., 0 = 100%, 1 
= 10%, 4 then 5 in quick 
succession = 45%)

Alt + Shift + [0 - 9] Mixer Brush changes Mix setting

[0 - 9] Mixer Brush changes Wet setting

0 Mixer Brush changes Wet and 
Mix to zero

Shift + + oder Shift 
+ -

Cycle through blending modes

Backspace oder 
Shift + Backspace

Open Fill dialog box on 
background or standard layer

Alt + Backspace 
or Ctrl + 
Backspace oder 
Ctrl + Backspace

Fill with foreground or 
background color. Hold down 
Shift to preserve transparency

Ctrl + Alt + 
Backspace

Fill from history. Hold down Shift 
to preserve transparency

Shift + Backspace Displays Fill dialog box

/ Lock transparent pixels on/off

Shift + Links Klick (Any painting tool) Connects 
points with a straight line

Using for blending modes
Shift + + oder Shift 
+ -

Cycle through blending modes

Shift + Alt + N Normal

Shift + Alt + I Dissolve

Shift + Alt + Q Behind (Brush tool only)

Shift + Alt + R Clear (Brush tool only)

Shift + Alt + K Darken

Shift + Alt + M Multiply

Shift + Alt + B Color Burn

Shift + Alt + A Linear Burn

Shift + Alt + G Lighten

Shift + Alt + S Screen
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Shift + Alt + D Color Dodge

Shift + Alt + W Linear Dodge

Shift + Alt + O Overlay

Shift + Alt + F Soft Light

Shift + Alt + H Hard Light

Shift + Alt + V Vivid Light

Shift + Alt + J Linear Light

Shift + Alt + Z Pin Light

Shift + Alt + L Hard Mix

Shift + Alt + E Difference

Shift + Alt + X Exclusion

Shift + Alt + U Hue

Shift + Alt + T Saturation

Shift + Alt + C Color

Shift + Alt + Y Luminosity

Shift + Alt + D (Sponge tool) Desaturate

Shift + Alt + S (Sponge tool) Saturate

Shift + Alt + S (Dodge tool/Burn tool) 
Dodge/burn shadows

Shift + Alt + M (Dodge tool/Burn tool) 
Dodge/burn midtones

Shift + Alt + H (Dodge tool/Burn tool) 
Dodge/burn highlights

Shift + Alt + N Set blending mode to Threshold 
for bitmap images, Normal for all 
other images

Selecting and editing text
Ctrl + Bewegen 
Sie die Maus

(Drag type when Type layer is 
selected) Move type in image

Shift + Pfeiltasten 
oder Ctrl + Shift + 
Linker Pfeil / 
Rechter Pfeil

Select 1 character left/right or 1 
line down/up, or 1 word left/right

Shift + Links Klick Select characters from insertion 
point to mouse click point

Pfeiltasten Move 1 character left/right, 1 line 
down/up, or 1 word left/right

Shift + Links Klick Create a new text layer, when a 
text layer is selected in the 
Layers panel

Doppelklick Select a word

Klicken Sie 
dreimal (schnell)

Select a line

Doppelklick + 
Doppelklick

(Quadruple-click) Select 
paragraph

Klicken Sie 
dreimal (schnell) + 
Doppelklick

(Quintuple click) Select story

Ctrl + H Show/Hide selection on selected 
type

Ctrl Display the bounding box for 
transforming text when editing 
text, or activate Move tool if 
cursor is inside the bounding box

Ctrl + Bewegen 
Sie die Maus

(Drag a bounding box handle) 
Scale text within a bounding box 
when resizing the bounding box

Space + Bewegen 
Sie die Maus

Move text box while creating text 
box

Format type
Ctrl + Shift + L (Horizontal Type tool) Align left

Ctrl + Shift + C (Horizontal Type tool) Align 
center

Ctrl + Shift + R (Horizontal Type tool) Align right

Ctrl + Shift + L (Vertical Type tool) Align left

Ctrl + Shift + C (Vertical Type tool) Align center

Ctrl + Shift + R (Vertical Type tool) Align right

Ctrl + Shift + X Choose 100% horizontal scale

Ctrl + Shift + Alt + 
X

Choose 100% vertical scale

Ctrl + Shift + Alt + 
A

Choose Auto leading

Ctrl + Shift + Q Choose 0 for tracking

Ctrl + Shift + J Justify paragraph, left aligns last 
line

Ctrl + Shift + F Justify paragraph, justifies all

Ctrl + Shift + Alt + 
H

Toggle paragraph hyphenation 
on/off

Ctrl + Shift + Alt + 
T

Toggle single/every-line 
composer on/off

Decrease or increase type size 
of selected text 2 points or 
pixels. Hold down Alt (Win) or 
Option (macOS) to 

Ctrl + Shift + < 
oder Ctrl + Shift + 
>
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decrease/increase by 10

Alt + Aufwärtspfeil 
/ Pfeil nach unten

Decrease or increase leading 2 
points or pixels. Hold down Ctrl 
(Windows) or Command 
(macOS) to decrease/increase 
by 10

Shift + Alt + 
Aufwärtspfeil / 
Pfeil nach unten

Decrease or increase baseline 
shift 2 points or pixels. Hold 
down Ctrl (Windows) or 
Command (macOS) to 
decrease/increase by 10

Alt + Linker Pfeil / 
Rechter Pfeil

Decrease or increase 
kerning/tracking 20/1000 ems. 
Hold down Ctrl (Windows) or 
Command (macOS) to 
decrease/increase by 10

Slice and optimize
Ctrl Toggle between Slice tool and 

Slice Selection tool

Shift + Bewegen 
Sie die Maus

Draw square slice

Alt + Bewegen Sie 
die Maus

Draw from center outward

Shift + Alt + 
Bewegen Sie die 
Maus

Draw square slice from center 
outward

Space + Bewegen 
Sie die Maus

Reposition slice while creating 
slice

Rechtsklick (Right click on slice) Open 
context-sensitive menu

Using panels
Alt (Click new button) Set options 

for new items (except for 
Actions, Animation, Styles, 
Brushes, Tool Presets, and 
Layer Comps panels)

Alt (Click Delete button) Delete 
without confirmation (except for 
the Brush panel)

Shift + Enter Apply value and keep text box 
active

Tab Show/Hide all panels

Show/Hide all panels except the Shift + Tab

toolbox and options bar

Enter (Select tool and then press 
Enter) Highlight options bar

Shift + 
Aufwärtspfeil / 
Pfeil nach unten

Increase/decrease selected 
values by 10

Using actions panel
Alt + Links Klick (Click the check mark next to a 

command) Turn command on 
and all others off, or turn all 
commands on

Alt + Links Klick Turn current modal control on 
and toggle all other modal 
controls

Alt + Doppelklick action or action set  Change 
action or action set options

Doppelklick (To recorded command) Display 
Options dialog box for recorded 
command

Ctrl + Doppelklick Play entire action

Alt + Links Klick (To triangle) Collapse/expand all 
components of an action

Ctrl + Links Klick Play a command

Alt + Links Klick (Click the New Action button) 
Create new action and begin 
recording without confirmation

Shift + Links Klick (Click the action/command) 
Select contiguous items of the 
same kind

Ctrl + Links Klick (Click the action/command) 
Select discontiguous items of the 
same kind

Using adjustment layers
Note: IF you prefer channel shortcuts starting with 
Alt/Option + 1 for red, choose Edit > Keyboard 
Shortcuts, and select Use Legacy Channel Shortcuts. 
Then restart Photoshop.

Alt + 3 Choose specific channel for 
adjustment (Red)

Alt + 4 Choose specific channel for 
adjustment (Green)

Alt + 5 Choose specific channel for 
adjustment (Blue)
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Alt + 2 Choose composite channel for 
adjustment

Del oder 
Backspace

Delete adjustment layer

Alt + Links Klick (To Auto button) Define Auto 
options for Levels or Curves

Using the Animation panel in 
Frames mode

Shift + Links Klick (Click on second frame) 
Select/deselect multiple 
contiguous frames

Ctrl + Links Klick (Click multiple frames) 
Select/deselect multiple 
discontiguous frames

Alt (Use Paste Frames command 
from the Panel pop�up menu) 
Paste using previous settings 
without displaying the dialog box

Using the Brush panel
Alt + Links Klick (Click on the brush) Delete brush

Doppelklick (Double click on the brush) 
Rename brush

Alt + Rechtsklick + 
Bewegen Sie die 
Maus

Drag left or right to change brush 
size

Alt + Rechtsklick + 
Bewegen Sie die 
Maus

Drag mouse down or up to 
decrease/increase brush 
softness/hardness

. oder , Select previous/next brush size

Shift + , oder Shift 
+ .

Select first/last brush

Caps Lock oder 
Shift + Caps Lock

Display precise cross hair for 
brushes

Shift + Alt + P Toggle airbrush option

Using the channels panel
Note: If you prefer channel shortcuts starting with 
Ctrl/Command + 1 for red, choose Edit > Keyboard 
Shortcuts, and select Use Legacy Channel Shortcuts.

Ctrl + 3 (Red) Select individual channels

(Green) Select individual Ctrl + 4

channels

Ctrl + 5 (Blue) Select individual channels

Ctrl + 2 Select composite channel

Ctrl + Links Klick (Click channel thumbnail) Load 
channel as selection

Alt + Ctrl + 3 Load channel as selection (red)

Alt + Ctrl + 4 Load channel as selection 
(green)

Alt + Ctrl + 5 Load channel as selection (blue)

Ctrl + Shift + Links 
Klick

(Click channel thumbnail) Add to 
current selection

Ctrl + Alt + Links 
Klick

(Click channel thumbnail) 
Subtract from current selection

Ctrl + Shift + Alt + 
Links Klick

(Click channel thumbnail) 
Intersect with current selection

Alt + Links Klick (Click Save Selection As 
Channel button) Set options for 
Save Selection As Channel 
button

Ctrl + Links Klick (Click Create New Channel 
button) Create a new spot 
channel

Shift + Links Klick (Click color channel) 
Select/deselect multiple color-
channel selection

Shift + Links Klick (Click alpha channel) 
Select/deselect alpha channel 
and show/hide as a rubylith 
overlay

Doppelklick (Double click alpha spot or spot 
channel thumbnail) Display 
channel options

~ Toggle composite and grayscale 
mask in Quick Mask mode

Using the Clone Source panel
Alt + Shift Show Clone Source (overlays 

image)

Alt + Shift + 
Pfeiltasten

Nudge Clone Source

Alt + Shift + < oder 
Alt + Shift + >

Rotate Clone Source

Alt + Shift + [ oder 
Alt + Shift + ]

Scale (increase or reduce size) 
Clone Source
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Using the color panel
Alt + Links Klick (Click color in color bar) Select 

background color

Rechtsklick (Right click color bar) Display 
Color Bar menu

Shift + Links Klick (Click color bar) Cycle through 
color choices

Using the history panel
Alt (Click New Snapshot) Create a 

new snapshot

Doppelklick Rename snapshot

Ctrl + Shift + Z Step forward through image 
states

Ctrl + Alt + Z Step backward through image 
states

Alt + Links Klick (Click the image state) Duplicate 
any image state, except the 
current state

Alt (Click Clear History in History 
panel pop�up menu) 
Permanently clear history (no 
Undo)

Using the Layers panel
Ctrl + Links Klick (Click layer thumbnail) Load 

layer transparency as a selection

Ctrl + Shift + Links 
Klick

(Click layer thumbnail) Add to 
current selection

Ctrl + Alt + Links 
Klick

(Click layer thumbnail) Subtract 
from current selection

Ctrl + Shift + Alt + 
Links Klick

(Click layer thumbnail) Intersect 
with current selection

Ctrl + Links Klick (Click filter mask thumbnail) 
Load filter mask as a selection

Ctrl + Shift + N New layer

Ctrl + J New layer via copy

Shift + Ctrl + J New layer via cut

Ctrl + G Group layers

Ctrl + Shift + G Ungroup layers

Ctrl + Alt + G Create/release clipping mask

Ctrl + Alt + A Select all layers

Ctrl + Shift + E Merge visible layers

Alt + Links Klick (Click New Layer button) Create 
new empty layer with dialog box

Ctrl + Links Klick (Click New Layer button) Create 
new layer below target layer

Alt + . Select top layer

Alt + , Select bottom layer

Shift + Alt + [ oder 
Shift + Alt + ]

Add to layer selection in Layers 
panel

Alt + [ oder Alt + ] Select next layer down/up

Ctrl + [ oder Ctrl + 
]

Move target layer down/up

Ctrl + Shift + Alt + 
E

Merge a copy of all visible layers 
into target layer

Ctrl + E (First, highlight layers you want 
to merge) Merge layers

Ctrl + Shift + [ 
oder Ctrl + Shift + 
]

Move layer to bottom or top

Alt (Use Merge Down command 
from the Panel pop�up menu) 
Copy current layer to layer below

Alt (Use Merge Visible command 
from the Panel pop�up menu) 
Merge all visible layers to a new 
layer above the currently 
selected layer

Rechtsklick (Right click the eye icon) 
Show/hide this layer/layer group 
only or all layers/layer groups

Alt (Click the eye icon) Show/hide 
all other currently visible layers

/ Toggle lock transparency for 
target layer, or last applied lock

Doppelklick (Double-click layer effect/style) 
Edit layer effect/style, options

Alt (Double-click layer effect/style) 
Hide layer effect/style

Doppelklick (Double-click the layer) Edit layer 
style

Shift + Links Klick (Click vector mask thumbnail) 
Disable/enable vector mask

Doppelklick (Double-click layer mask 
thumbnail) Open Layer Mask 
Display Options dialog box
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Shift + Links Klick (Click layer mask thumbnail) 
Toggle layer mask on/off

Shift + Links Klick (Click layer mask thumbnail) 
Toggle filter mask on/off

Alt + Links Klick (Click layer mask thumbnail) 
Toggle between layer 
mask/composite image

Alt + Links Klick (Click filter mask thumbnail) 
Toggle between filter 
mask/composite image

\ oder Shift + Alt + 
Links Klick

Toggle rubylith mode for layer 
mask on/off

Doppelklick (Double-click type layer 
thumbnail) Select all type; 
temporarily select Type tool

Alt + Links Klick (Click the line dividing two 
layers) Create a clipping mask

Doppelklick (Double-click the layer name) 
Rename layer

Doppelklick (Double-click the filter effect) Edit 
filter settings

Doppelklick (Double-click the Filter Blending 
icon) Edit the Filter Blending 
options

Ctrl + Links Klick (Click New Group button) Create 
new layer group below current 
layer/layer set

Alt + Links Klick (Click New Group button) Create 
new layer group with dialog box

Alt + Links Klick (Click Add Layer Mask button) 
Create layer mask that hides 
all/selection

Ctrl + Links Klick (Click Add Layer Mask button) 
Create vector mask that reveals 
all/path area

Ctrl + Alt + Links 
Klick

(Click Add Layer Mask button) 
Create vector mask that hides all 
or displays path area

Rechtsklick (Right click layer group and 
choose Group Properties) 
Display layer group properties

Doppelklick (Double-click on the group) 
Display layer group properties

Shift + Links Klick Select/deselect multiple 
contiguous layers

Select/deselect multiple Ctrl + Links Klick

discontiguous layers

Using the Layer Comps panel
Alt + Links Klick (Click Create New Layer Comp 

button) Create new layer comp 
without the New Layer Comp 
box

Doppelklick (Double-click layer comp) Open 
Layer Comp Options dialog box

Doppelklick (Doubleclick layer comp name) 
Rename in-line

Shift + Links Klick Select/deselect multiple 
contiguous layer comps

Ctrl + Links Klick Select/deselect multiple 
discontiguous layer comps

Using the Paths panel
Ctrl + Links Klick (Click pathname) Load path as 

selection

Ctrl + Shift + Links 
Klick

(Click pathname) Add path to 
selection

Ctrl + Alt + Links 
Klick

(Click pathname) Subtract path 
from selection

Ctrl + Shift + Alt + 
Links Klick

(Click pathname) Retain 
intersection of path as selection

Ctrl + Shift + H Hide path

Alt + Links Klick Set options for Fill Path with 
Foreground Color button, Stroke 
Path with Brush button, Load 
Path as a Selection button, Make 
Work Path from Selection button, 
and Create New Path button

Using the Swatches panel
Links Klick (Click in empty area of panel) 

Create new swatch from 
foreground color

Ctrl + Links Klick (Click swatch) Set swatch color 
as background color

Alt + Links Klick (Click swatch) Delete swatch

Using Extract and Pattern Maker 
(optional plug-ins)
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Ctrl + 0 Fit in window

Ctrl + + Zoom in

Ctrl + - Zoom out

Tab Cycle through controls on right 
from top

Shift + Tab Cycle through controls on right 
from bottom

Space Temporarily activate Hand tool

Alt Change Cancel to Reset

Sonuç (Yalnızca Extract)
B Edge Highlighter tool

G Fill tool

I Eyedropper tool

C Cleanup tool

T Edge Touchup tool

Alt (Click Edge Highlighter/Eraser 
tool) Toggle between Edge 
Highlighter tool and Eraser tool

Ctrl (With Edge Highlighter tool 
selected) Toggle Smart 
Highlighting

Alt + Del Remove current highlight

Ctrl + Del Highlight entire image

Shift + Links Klick (With Fill tool selected) Fill 
foreground area and preview 
extraction

Ctrl + Bewegen 
Sie die Maus

Move mask when Edge Touchup 
tool is selected

Alt + Bewegen Sie 
die Maus

Add opacity when Cleanup tool 
is selected

X Toggle Show menu options in 
preview between Original and 
Extracted

Shift + X Enable Cleanup and Edge 
Touchup tools before preview

F Cycle through Display menu in 
preview from top to bottom

Shift + F Cycle through Display menu in 
preview from bottom to top

Aufwärtspfeil / 
Pfeil nach unten

(In Brush Size text box) 
Increase/decrease brush size by 
1

Linker Pfeil / 
Rechter Pfeil

(With Brush Size Slider showing) 
Decrease/increase brush size by 
1

[0 - 9] Set strength of Cleanup or Edge 
Touch�up tool

Result (Pattern Maker only)
Ctrl + D Delete current selection

Ctrl + Z Undo a selection move

Ctrl + G Generate or generate again

Shift + Alt (Select while holding) Intersect 
with current selection

X Toggle view: original/generated 
pattern

Home Go to first tile in Tile History

End Go to last tile in Tile History

Left oder Page Up Go to previous tile in Tile History

Right oder Page 
Down

Go to next tile in Tile History

Del Delete current tile from Tile 
History

Pfeiltasten Nudge selection when viewing 
the original

Shift + Pfeiltasten Increase selection nudging when 
viewing the original

Letzte Änderung: 20.05.2020 18:47:16

Mehr Informationen: defkey.com/de/adobe-
photoshop-tastaturkurzel

Passen Sie dieses PDF an...
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